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Entering Your Key
Entering your trial key allows you to save your projects 
and print them during your evaluation period. Entering 
your license key allows you do the same, except with-
out any time limitations. 

1. Start by opening up an image in Photoshop. 
2. Go to Filters -> Topaz Labs -> InFocus -> Menu -> 
Enter key. 
3. You can then copy and paste or type your key in.

Important: To install the product on a second comput-
er, you will need to download Topaz InFocus and then 
enter your same license key.

Host-Specific Installation
Topaz InFocus is also compatible with Lightroom, Aper-
ture and iPhoto.  To use InFocus in any of these pro-
grams you will need to download and install the free 
Topaz Fusion Express compatibility add on.  You can 
get it online at: www.topazlabs.com/downloads

In Windows, Topaz InFocus is supported by most host 
applications that support Photoshop plug-ins.  This 
includes Paint Shop Pro, Photo Impact, Painter, and 
Irfanview, although there are additional host programs 
that may also support Topaz InFocus. 

To install InFocus in Paint Shop Pro, Photo Impact, or 
Irfanview, first download Topaz InFocus to the default 
location.  Then, to configure InFocus into each program 
follow the host-specific instructions on the next page. 

Topaz InFocus is a Photoshop plug-in, which means 
it won’t run by itself and requires a compatible host 
program. 

To Install
1. Close Photoshop or other image editing program if 
you are using it. 

2. Open the Topaz InFocus dmg or zip file, double-click 
on the Topaz InFocus installer, and then follow the on-
screen instructions. 

3. Your Topaz plug-ins will automatically be installed in 
your Photoshop plug-ins folder. 

4. After the installation, you will need to enter your 
license or trial key. 

Important for Mac Users: 
After installation, Topaz InFocus will be installed in the 
following folder: “ Macintosh HD -> Library -> Applica-
tion Support -> Topaz Labs -> InFocus”.

If your Photoshop is installed in a customized location, 
you will need to manually create a shortcut (alias) link 
inside folder “<Photoshop install folder> -> Plug-ins” 
that links to “ Macintosh HD -> Library -> Application 
Support -> Topaz Labs -> InFocus -> Plug-ins”.

Installation

             Mac Dmg           Windows Zip
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How to install Topaz InFocus in Paintshop Pro 
1. First launch PaintShop Pro.

2. Go to Menu file -> Preferences -> File Locations. 
Select “Plug-ins” from the “File Types” list and click 
“Add”. 

Installation
3. Choose C: \ Program Files \ Topaz Labs \ Topaz InFo-
cus plug-ins and click “OK”. 

4. Topaz InFocus is now available to use.  Simply go to 
Effects -> Plug-ins and select “Topaz InFocus”.
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How to install Topaz InFocus in Photo Impact 
1. First launch  Photo Impact.

2. Go to File -> Preferences -> General or use shortcut 
key F6. 

3. Select Plug-ins from the Categories list. 

Installation
Then click on the           button and browse to find the 
InFocus plug-in folder located in:  C: \ Program Files \To-
paz Labs \ Topaz InFocus plug-ins and then click “OK”. 

4. Restart Photo Impact.  Go to Menu -> Effect to ac-
cess plug-in.
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How to install Topaz InFocus in Irfanview
1. Make sure that you have downloaded and installed 
the 8bf plug-in add-on, available on the Irfanview 
webpage. (http://www.software.com/irfanview-plugin)

2. Open Irfanview and go to Image -> Effects -> Adobe 
8BF filters. 

3. In the screen that pops up, select “Add 8BF filters” 
and navigate to the C: \ Program Files \ Topaz Labs \ 
Topaz InFocus \ Plug-ins folder and click “OK”. You will 
then see “Topaz InFocus” in the Available / Loadable 
8BF Filters section. 

4. To use Topaz InFocus in the future, simply go to 
Image -> Effects> Adobe 8BF filters again and select 
“Topaz InFocus”.

Installation
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Uninstalling
3. Select Programs, then Uninstall a Program.

4. Select Topaz InFocus and click remove. 

Windows 7*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel -> 
Programs -> Programs and Features. 

3. Select Topaz InFocus and click uninstall. 

*Please note that if you also have the 64-bit version of 
InFocus installed, then you will need to first uninstall 
this version before you can uninstall the regular ver-
sion. 

To uninstall Topaz InFocus follow these instructions:

Mac
1. Quit Photoshop (or other editing program).

2. Navigate to the Topaz Labs support files and frames 
located at: Macintosh HD -> Library -> Application Sup-
port -> Topaz Labs. 

3. Locate the Topaz InFocus file and move it to the 
trash.  You will need to enter your system password 
to OK this change. 

4. Navigate to your Photoshop plug-ins folder located 
at: Applications -> Photoshop -> Plug-ins

5. Locate any leftover Topaz InFocus files and move it 
to the trash. 

Windows XP*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.

3. Double-click on Add / Remove programs.

4. Select Topaz InFocus and click remove. 

Windows Vista*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.
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Sharpening
What is sharpening?
Sharpening is the process of enhancing the apparent 
detail or sharpness of an image.  While no new informa-
tion is added to the image, sharpening will create an 
“optical illusion” of sharpness by boosting edge con-
trast, enhancing what is already in the image.

Unsharp Mask
One of the commonly used sharpening methods in 
digital image-processing is unsharp masking.  Unsharp 
masking detects the edges within an image and in-
creases the percieved sharpness by creating more 
drastic tonal transitions (contrast boost).  Many times, 
this boost in edge contrast can produce a harsh unap-
pealing  look.

Deconvolution
In image processing, deconvolution is the process of 
approximately reversing the process that caused an 
image to be blurred. While unsharp masking increases 
the perceived sharpness of an image, deconvolution 
increases the actual sharpness based on information 
which describes some of the likely origins of the distor-
tions when capturing the image. With deconvolution, 
“lost” image detail may be approximately recovered.  
This technology can be applied to both enhancing the 
clarity in an already well-focused image, as well as de-
blurring out-of-focus or motion blurred images.

Introduction

Original (well-focused)

Out-of-Focus Image

Unsharp Mask Technology
Note obvious contrast

Deconvolution Technology
(Topaz InFocus)
Compare with Original!
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Topaz InFocus
About Topaz InFocus

Topaz InFocus uses the most recent image sharpening 
technology to provide unparralleled, intuitive detail 
refinement.  It is the ultimate tool for superior sharp-
ening, as well as de-blurring out-of-focus and motion 
blurred images.

With Topaz InFocus, you gain tools to improve image 
clarity simply and effectively.  Whether refining fine im-
age features or rescuing a previously unusable out-of-
focus image, Topaz InFocus is the most advanced, yet 
user-friendly, solution to your sharpening needs.

Using the most recent deconvolution technology, 
Topaz Infocus actually reverses the blurring process, 
allowing lost detail to essentially be recovered.  Topaz 
InFocus offers you unprecedented de-blurring technol-
ogy and fine detail enhancement for optimal results on 
every image.

The Primary Functions of Topaz InFocus Include: 

1. Sharpening and refining detail for a crisp and clear 
image.

2. Reverse image blur, recovering original image detail 
in both out-of-focus and motion-blurred images. 

3. Restore true color and detail to image features 
obscured by natural haziness (caused by atmospheric 
effects).

4. Micro-contrast fine detail enhancement, used to 
enrich subtle structure features.

Introduction

To connect with other Topaz users, participate in Topaz 
contests and to see the latest tips, tricks and tutorials sign 

up for the new Topaz Forum online at:
 www.topazlabs.com/forum

After Topaz InFocus

Before Topaz InFocus
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InFocus Features
Topaz InFocus Features

1. DeBlur Tab.  Multiple sliders included to control 
generic, out-of-focus and motion blur. 

2. Sharpen Tab.  Mulitple sliders included to control 
sharpening and micro-contrast detail enhancement.

3. Estimate Blur Button.  Automatic estimation option 
for unknown or complex blur types.
 
4. Auto Updater.  Get software updates instantly.

5. Snap / Recall buttons.  Save up to 99 snapshot set-
tings for comparison. 

6. Undo / Redo buttons. 

7. Collapsible side panels.  Expand and collapse the 
preset and tool panel for an adjustable workspace. 

8. Preset Enable / Disable option.  Option to enable 
or disable the preset preview processing at program 
startup. 

9. Preset Navigation.  Use the up / down arrow keys 
to navigate the preset list and display the selected 
preset thumbnail (in preset preview window). Use 
the return (Enter) key to apply the currently selected 
preset.

10. Enable / Disable Tool Tips.  Option to enable or dis-
able the pop up tool tips. 

11. Quick Slider Reset.  Double click on the slider name 
to reset default slider values.

Introduction

Before Topaz InFocus

After Topaz InFocus
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Introduction

Before Topaz InFocus
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Introduction

After Topaz InFocus
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Work Area

Interface (Main View)
Although the Topaz InFocus interface may look intimidating at first glance, don’t worry: it’s actually quite simple and 
easy to use.  You’ll soon be a pro after experimenting with it for a bit.  In order to make sense of the function of each of 
the various controls, we have divided the interface into a few sections:

1

2

4

1. Presets Preview 5. Settings & Parameters2. Presets Panel 4. Preview Navigator
The removable pre-
view window displays
preset previews. 

Controls the editing using sliders 
to adjust the various effects.

Provides “snapshots”
 of pre-defined effects.

Displays the region of the
preview image you are 
currently focused on. 

3. Preview Window
Displays the preview of the 
original and adjusted image. 

3

5
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Work Area

Interface (Tool Panel View)
Use the small white arrows to expand and collapse the preset panel.  You can click the white arrow            or grab the 
edge of the panel and drag it in or out.
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Work Area

Interface (No Panel View)
Use the small white arrows to expand and collapse the preset and tool panels.  You can click the white arrows                    
or grab the edge of the panels and drag them in or out.
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Work Area

Interface (Preset Panel View)
Use the small white arrows to expand and collapse the tool panel.  You can click the white arrow                or grab the 
edge of the panel and drag it in or out.
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To pan the preview image, click and hold the left 
mouse button on the preview image and drag it 
around.  When you let go of the mouse button, the 
new portion of the image will be processed and the 
result will be displayed. 

Preview Section 
The Preview section is the main window that is cen-
tered in the InFocus interface.  The preview section 
shows you the original image and the processed pre-
view of the image.  Click on the image in the preview 
window (or use the Original and Preview buttons) to 
switch between the Original and Preview tabs and 
compare the filtered and un-filtered images. 

Work Area

You can also use SPACE bar or your numbered shortcut 
keys “1” and “2” to switch back and forth between your 
filtered and unfiltered image in the preview window.

1
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The “Ctrl +” and “Ctrl –” keys zoom in and out of the 
image, just like in Photoshop.  

You can use the arrow keys to adjust the value of the 
slider that is currently selected.  

A complete list of the shortcut keys can be found in 
the Shortcut Keys section later in this manual.

You can zoom in or out of the preview image by click-
ing the “+”, or “-” buttons below the preview image.
You can also resize the window as well by dragging 
the bottom right corner in and out. 

Work Area

Photoshop and other host software support many Image 
Modes, such as Grayscale, RGB, LAB, CMYK, etc.  Images 
can also be 8, 16, or 32 bits per channel. Topaz InFocus 
supports both 8 bits per channel and 16 bits per chan-
nel.  Topaz InFocus supports RGB mode only.  To work on 
black-and-white images, first convert them to RGB mode.
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Work Area

Presets
Presets are a great way to speed up and simplify the 
whole process of using Topaz InFocus.  Presets are 
set previews with previously defined settings that you 
can recall and reapply at any time. 

We’ve included some default presets for you and, al-
though they won’t work for every single photograph, 
they serve as excellent starting points for customized 
tweaking.  

Applying Presets 
Applying a default preset is easy and intuitive.  Simply 
clicking on a preset will change all the settings in To-
paz InFocus to match those in the selected preset. 

To get the exact results you want, you may still want 
to go through the tabs and tweak the parameters.

Adding Presets
Sometimes it’s convenient to be able to define pre-
sets and save your settings for later use.  To do this, 
first adjust the Topaz InFocus parameters until you’re 
satisfied with the result.  Then, click on “Save”. 

 
 

1. Presets Preview
The removable preview 
window displays
preset previews.  Click 
Hide / Show to expand or 
collapse the preset pre-
view window at anytime 
during your workflow.

2
2. Presets List
Lists all of the saved pre-
sets available for use. 

1

3. Preset Options

The preset options al-
low you to save your 
presets, delete presets 
(default presents cannot 
be deleted), import new 
presets and export your 
saved presets to share 
with your friends. 

Remember that you can easily expand or collapse the presets 
panel by clicking on the small white arrow on the edge of the 
panel or by grabbing the panel edge and dragging it in or out.

3
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Work Area
Then enter a preset name, select the type of image 
that it is good for and then enter a description and 
click “OK”.  You can also select a second image cat-
egory type that the preset is good for. 

Note that if the name you’ve entered is the same as a 
preset you’ve already defined then you will be asked if 
overwrite the previous one. 

Your preset will be automatically saved as a new file 
with a “.tpp” extension in the Topaz InFocus Presets 
menu and the preview is automatically generated.  To 
apply it later, just click it like any other preset. 

Deleting Presets
If you’d like to delete a preset the select the preset 
name and then click on Delete.  

Please Note: Default presents cannot be overridden 
or deleted.  Once you delete a preset it or overwrite it 
when saving, then it cannot be retrieved.  

Saved presets are located in the Topaz InFocus “Presets” folder:
C: \ Program Files \ Topaz Labs \ Topaz InFocus \ Presets unless 
you’ve opted to install Topaz InFocus into a different directory. 

Mac users have this folder at Macintosh HD / Library / Applica-
tionSupport /TopazLabs / InFocus / Presets. 
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Work Area
Exporting Presets
To export the preset file to a certain location, click 
“Export”. 

Name your preset and save it to your desktop or 
other specified location that you have reserved for 
saved presets.

You can then share this preset file with others who 
may then import it. 

Sharing Presets
Feel free to share your saved presets by emailing 
them to your friends and having them put it into their 
Topaz InFocus Presets folder.  

Importing Presets
To import a preset file, click the “Import” button.

This will open up a “Browse” box to import a saved 
preset from your computer into Topaz InFocus. This is 
useful if you have downloaded a preset file that you’d 
like to use. 

Visit the Topaz Labs Blog which features the latest 
Photography, software and design information including 

tutorials, videos, and thoughts about both Topaz and 
non-Topaz topics.
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4

3

2

Work Area

Tools
You will use the various tools in the tools panel during 
your workflow to make your image adjustments.

1. Preview Navigator - Displays the region of the
preview image you are currently focused on.

2. Zoom Buttons - Use the zoom buttons to zoom in 
and out of your image.  Or you can also set your image 
to fit the preview window or to view it at 100%. 

3. Undo and Redo buttons. Snap and Recall buttons.  
Save up to 99 snapshot settings for comparison. 

4. Sliders and Parameters - Controls the editing pro-
cess using sliders to adjust the various effects.

5.  Additional Slider Controls - Use the “Reset All” but-
ton to reset all of the sliders values back to zero. 

 

1

Note:  The Estimate Blur button is only an option when
the Unknown/Estimate blur type is chosen.

In any other blur type is chosen, the Estmate Blur
feature is not available. 

5
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Check for Update
Checks for available Topaz InFocus’ updates. 

Click the Show Details button to get find out what’s 
included in the update before you install. 

Menu
You can access Topaz InFocus’s menu by clicking on the 
“Menu…” button at the bottom of the interface. 

Preferences
Select this to enable or disable the program tool tips 
or the Auto-Update feature. 

Work Area
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Enter Key
Select this to enter your trial or purchased license key. 

What’s This?
Select this (or click F1) then click on a feature in the 
Simplify interface to learn more about it. 

Users Guide
Select it to pull up this user guide.

Tech Support
Brings you to the Topaz Labs support page where 
you can request assistance from our support special-
ists, contact our customer service team, retrieve lost 
license keys, or browse through our Knowledge Base. 

Product Info
Select this to go to the Topaz InFocus web page to 
learn more about the Topaz InFocus plug-in.

MyTopaz
Brings you to the Topaz community where you can 
connect and interact with other Topaz users.  Here 
you can also participate in discussions and contests, 
and share your favorite Topaz images. 

Tutorials
Brings you to the Topaz InFocus tutorials page where 
you can access a variety of helpful video and text tu-
torials.  You can also submit tutorials that you created 
here as well.

About
Select this to see what version of InFocus you cur-
rently have.

Work Area
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Settings & Parameters 

Parameters
 Topaz InFocus has two settings tabs and a total of 6 
parameters plus 4 blur types to help you achieve opti-
mal image results. 

Deblur
The Deblur tab includes the basic and most essential 
sharpening and deblurring tools.  These tools are the 
main ones that you will use, and they will solve most of 
your sharpening and de-blurring needs.

Blur Type
There are three blur types to choose from: Generic 
(which is the primary type for sharpening needs), Out-
of-Focus, Straight Motion and Complex Unknown.

Blur Radius
The Blur Radius refers to the blur width of your pix-
els.  This is the most important slider in InFocus, and is 
where the deconvolution process takes place.  Even if 
your image is not “blurry”, this parameter whould be 
the first step in your detail enhancement.  Gradually 
increase this slider to determine the correct setting.  If 
the radius is increased too much, artifacts are created, 
so be careful not to set it too high.

InFocus Usage Tips:

Be sure not to overuse the “Blur Radius” slider or this may 
cause image artifacts to appear. 

More advanced users, or images suffering from serious 
artifacts, may require additional use the of the “Suppress 
Artifacts” slider.

Important Blur Type Tips:

When you have a well focused
 image, and would like only to 
enhance image clarity, choose 
the “Generic” blur type.  This 
will offer the best  results for minor adjustments and 
sharpening.  Use the “Out-of-Focus” blur type for 
slightly out of focus images.  The “Straight Motion” blur 
type is useful for motion blur, especially in forensic pho-
tography.  Use the “Unknown/Estimate” option, with 
the “Estimate Blur” button, if the blur is complex or you 
would like to auto-estimate the blur.
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Motion Angle
The motion angle parameter can only be used when 
the Blur Type is set to “Motion” (which should only be 
chosen if a motion blur is present in your image). This 
slider should be moved to the angle in which the mo-
tion blur is occuring.  A setting of “0.00” is at an angle 
of 0 degrees...the numbers correlate directly to the 
angle degree in which the motion is occurring within 
the image.

Edge Softness
The Edge Softness parameter is only viewable and ac-
cessible when in the “Uknown/Estimate” blur type.  It 
will replace the Motion Angle parameter during this 
mode.  After an auto blur estimation, there are times 
when overshooting, or over-sharpening, may occur in 
areas of your image.  Increasing the Edge Softness  will 
smooth out these harsher areas without decreasing 
your overall image clarity.  

Settings & Parameters 

Motion Angle Tips:

Important!  This slider is only accessible 
when the “Straight Motion” Blur Type is 
selected.  

The motion angle slider correlates to 
the angle degree of the motion blur. 
The diagram to the left depicts how the 
motion angle is determined.

0°

45°

Blur Estimation Tips:

Important!  The Blur Radius and Edge Softness parameters 
must be set BEFORE the Estimate Blur button is selecected.  
Each time either of these settings are changed, the Esti-
mate Blur button MUST be selected again for the changes 
to take effect.

 Additionally, please note that the estimation will differ de-
pending upon what part of the image is being viewed.  For 
example, if you are zoomed in on the background of your 
image, this will produce a different estimation than when 
you are viewing the foreground of your image.  For the blur 
estimation to work properly, choose an area of your image 
that has multiple edges present.  You may need to experi-
ment with different areas of your image until the optimal 
results are achieved .
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Suppress Artifacts
There are times when the deblurring and sharpening 
process may cause image artifacts to appear.  This 
parameter can help to suppress these artifacts, while 
still allowing for sharp image clarity.  Note that the 
default is set to .20.  As this slider is increased, more 
artifacts are suppressed, however a decrease in image 
clarity may occur.  As the Suppress Artifacts slider is 
decreased, overall image detail is increased, however 
more image artifacts may be apparent.

What are artifacts?
Image artifacts are different types of undesireable 
elements within a digital image.  The below image is a 
close-up of image artifacts produced due to extreme 
over-sharpening. 

Sharpen
The Sharpen tab has additional sharpening and fine 
detail micro-contrast enhancement tools.

Micro Contrast
The Micro Contrast parameter is for refining fine de-
tails, which will subtly enhance structure features.

Sharpness
There may be images that benefit from a little extra tra-
ditional sharpening at times.  Using a more advanced 
unsharp masking technology, this slider will subtly 
intensify the sharpness of your image and correlates 
directly to the Sharpness Radius slider. 

Sharpness Radius
This parameter correlates to the Sharpness slider and 
should be used sparingly.  If extra sharpness in an im-
age is needed, slowly increase this slider until the best 
results are achieved.

Settings & Parameters 

Example of Image Artifacts
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Workflow
We will be using this focused, but slightly hazy image 
for our example.  The goal for this image is to gain 
overall image clarity and to enhance the small land-
scape details.  In the following steps, we will show 
you how to achieve optimal results with your own 
photos, following this model. So, let’s get started.

1. Open an image file. 

2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”.  You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

Sample Project #1
In this section, we will walk you through a sample 
project, step-by-step, to help you become more famil-
iar with the InFocus program focusing on using the 
default presets.

Before Topaz InFocus

After Topaz InFocus
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Workflow
We want to slightly sharpen the entire image, bring-
ing out the true color and clarity of the landscape.  To 
achieve this we will be working with the presets for 
this example, but you can start any way you like.

3. To begin working on your image go to Filters -> 
Topaz Labs -> InFocus.

4. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image.  Then you 
can click on the preview and drag it around until you 
find an area that you like. 
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Workflow

If you are satisfied with the preset adjustments then 
you can click “OK” to process your image and save it 
back to Photoshop. Since I am happy with the imme-
diate results I will go ahead and click OK to save and 
process my changes. 

For this example, only the Presharpening - Common 
preset was used to sharpen the image. 

5. If you want to choose a default preset, scroll 
through the panel on the left side of the screen. 
To select it, just click on it and the sliders will 
automatically adjust to the pre-defined settings 
and parameters. For this example we will be 
using the Presharpening - Common preset.

Don’t forget that you can use the shortcut keys in 
Topaz InFocus to speed up your workflow.
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Workflow

Before Topaz InFocus
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Workflow

After Topaz InFocus
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Workflow
We will be using this slightly out-of-focus image of 
New York City.  The goal for this image is to gain over-
all image clarity and to enhance the details and lines 
in the cityscape.  In the following steps, we will show 
you how to achieve optimal results with your own 
photos, following this model. So, let’s get started.

1. Open an image file. 

2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”.  You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

Sample Project #2
In this project, we will walk you through a second 
InFocus workflow to show you how to better achieve 
your sharpening goals using the sliders in both the 
Deblur and Sharpen tabs.

Before Topaz InFocus

After Topaz InFocus
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Workflow
We want to sharpen the entire image, recovering lost 
detail and restoring the true clarity of the scene.  To 
achieve this we will be working with the presets and 
sliders together.

3. To begin working on your image go to Filters -> 
Topaz Labs -> InFocus.

4. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image.  Then you 
can click on the preview and drag it around until you 
find an area that you like. 
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Workflow
If you are satisfied with the preset adjustments then 
you can click “OK” to process your image and save it 
back to Photoshop.

If you would like to make some additional adjust-
ments to your enhancement settings then you can do 
so by adjusting any of the sliders in the two tabs man-
ually until you achieve your preferred image results. 

 

5. If you want to choose a default preset, scroll 
through the panel on the left side of the screen. 
To select it, just click on it and the sliders will 
automatically adjust to the pre-defined settings 
and parameters. For this image we will be 
trying the Presharpening - Common prese.  
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Incorporating Manual Adjustments:

Start by choosing the blur type in your image.  Then 
move on to the Deblur tab sliders, followed by the 
sliders in the Sharpen tab.  This workflow allows for 
the optimal sharpening and deblurring results.

For information on specific blur types, please see page 25.

1. For minor adjustments and standard sharpening, 
“Generic” blur type usually does the trick (and is 
the default blur type for InFocus).  For this image, 
because it is just slightly out-of-focus, we will select 
the “Out-of-Focus” blur type to see if there is any 
improvement.  There is an immediate improvement in 
the image clarity, however let’s see if we can enhance 
the detail further.  

Workflow
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Workflow
2. The first slider to adjust is the “Blur Radius”.  
Gradually increase this slider to determine the correct 
setting.  If the radius is increased too much, artifacts are 
created, so be careful not to set it too high.

3. Notice that the “Motion Angle” is inactive while in the 
Out-of-Focus blur type.

4.  When increasing your Blur Radius, you may notice 
that parts of your image look great, while others are 
starting to show artifacts.  Use the “Suppress Artifacts” 
slider to decrease any image artifacts.  Increasing this 
parameter will cause your image to soften, so be careful.

5. If needed, move on to the Sharpen tab.  Use the 
“Micro Contrast” slider to increase fine detail, enhancing 
structure features.  Setting this parameter too high may 
give the illusion of noise, so keep an eye out.

6. The “Sharpness” parameter is a more traditional form 
of unsharp masking.  This parameter is nice for images 
that may need that extra boost of sharpening.  Use spar-
ingly to avoid high-contrast edges.

7. The last slider is “Sharpness Radius”, which cor-
relates to the Sharpness parameter.  The higher the 
radius setting, the thicker the edges appear.

 The best way to get great-looking images is to experiment with 
the filter until you’re satisfied. Despite the number of sliders and 
settings, getting a great result is easier than you might think!

Need to reset your slider values? 
Simply  double-click on the slider name above the slider 

control to instantly reset the slider value to 0. 
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Workflow

9. Once you are happy with your preset selection and 
your manual adjustments you are ready to click OK 
and watch your image transform.  

After Topaz InFocus

Before Topaz InFocus

Please visit the Topaz InFocus website at http://www.
topazlabs.com/infocus for video tutorials, tips, and tricks!
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Workflow
We will be using this motion blurred image for our 
example.  The goal for this image is to ascertain the 
license plate information, otherwise obscurred by 
the motion of the car.  In the following steps, we will 
show you how to achieve optimal results. So, let’s get 
started.

1. Open an image file. 

2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”.  You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

Sample Project #3
In this project, we will walk you through a third 
InFocus workflow, especially useful for forensic and 
police photography.

Before Topaz InFocus

After Topaz InFocus
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Workflow
We want to deblur the image enough to identify the 
license plate information.  To do this, we will be using 
the Straight Motion blur type and further parameter 
adjustments to achieve optimal results. 

5. Because this image shows an obvious motion blur, 
choose “Straight Motion” as the blur type.  This set-
ting is especially useful for forensic photography, 
when information, not beauty, is the goal of the 
deblurring.

3. To begin working on your image go to Filters -> 
Topaz Labs -> InFocus.

4. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image.  Then you 
can click on the preview and drag it around until you 
find an area that you like. 
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Workflow

8.  Increasing the Blur Radius to 6, the license plate 
information becomes significantly more clear. You can 
now move on to the other adjusments to improve the 
final image.

Note: You may notice the appearance of artifacts 
in your image.  Artifacts tend to be more significant 
when in the Straight Motion blur type.  

 

6. Next, choose the “Motion Angle” of the blur.  
Inspecting the blur in the example image, there is a 
noticeable blur of approximately 45˚.

7. After setting the Motion Angle, you now move on 
to the “Blur Radius” parameter.  Because there is a 
significant blur in this image, I choose Blur Radius of 4.

Below are the results from the Motion Angle and 
Blur Radius adjustments.  As you can see, there is still 
some work to do.

Motion Angle Tips:

The motion angle slider correlates to 
the angle degree of the motion blur. 
The diagram to the left depicts how the 
motion angle is determined.

0°

45°

The Motion Angle and Blur Radius are the most important 
parameters when in the Straight Motion blur type.  
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Workflow

If you are satisfied with the adjustments, you can 
click “OK” to process your image and save it back to 
Photoshop. Since I am happy with the results in my 
example image, I will go ahead and click OK to save 
and process my changes. 

For this example, the goal was to be able to identify 
the vehicle through the license plate information, 
which was significantly blurred by motion.  The license 
plate can now be read, therefore, the goal was met.

9.  The “Suppress Artifacts” adjustment will help to 
reduce any strong artifacts in your image.  Slowly 
increase this slider until the best results are achieved.  
Overuse of this parameter may introduce more arti-
facts into your image, so be careful.

10. At this point, you may use the sliders in the Sharp-
en tab for any additional sharpening needs.

Don’t forget that you can use the shortcut keys in 
Topaz InFocus to speed up your workflow.
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Workflow
We will be using an image with an unknown and com-
plex blur type as the example.  The goal for this image 
is to gain overall image clarity and to enhance struc-
ture features.  In the following steps, we will show 
you how to achieve optimal results with your own 
photos, following this model. So, let’s get started.

1. Open an image file. 

2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”.  You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

Sample Project #4
In this project, we will walk you through a fourth 
InFocus workflow, focusing on the blur estimation 
capablities in the program.

Before Topaz InFocus

After Topaz InFocus
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Additionally, we want to deblur and sharpen the 
entire image, enhancing the detail and clarity.  To 
achieve this we will be working with the Unknown/Es-
timate blur type and the blur estimation option.  

5. Choose the “Unknown/Estimate” blur type.  Notice 
that the lower right “Estimate Blur” button becomes 
active.

3. To begin working on your image go to Filters -> 
Topaz Labs -> InFocus.

4. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image.  Each part 
of the image will create a different and unique blur 
estimation, so we want to be sure and choose an area 
that you are trying to focus on.  For this image, I will 
choose the gas pump, as it has many details that I 
would like to enhance. 
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Workflow
6. Set your Blur Radius to an appropriate setting for 
the image blur. For this image, I will try a Blur Radius 
of 3. You may need to try several settings before you 
find the best one for optimal image results.

7.  Then, click on the Estimate Blur button and watch 
your image transform.  If you find that the estimation 
was overall too strong or weak, reset your Blur Ra-
dius accordingly and click on the Estimate Blur button 
again.

8.  If you see some areas of the image that are too 
strong, but others look good, try adjusting the Edge 
Softness parameter.  If image artifacts appear, in-
crease the Suppress Artifacts slider.  

For this example, only the Blur Estimate at Blur Radius 
3 was used to sharpen the image. 

 Blur Estimation Tips:

Important!  The Blur Radius and Edge Softness parameters 
must be set BEFORE the Estimate Blur button is selecected.  
Each time either of these settings are changed, the Esti-
mate Blur button MUST be selected again for the changes 
to take effect.

 Additionally, please note that the estimation will differ de-
pending upon what part of the image is being viewed.  For 
example, if you are zoomed in on the background of your 
image, this will produce a different estimation than when 
you are viewing the foreground of your image.  For the blur 
estimation to work properly, choose an area of your image 
that has multiple edges present.  You may need to experi-
ment with different areas of your image until the optimal 
results are achieved .
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Glossary
Edge Artifacts – The “ringing” artifacts or distortions 
found around image edges.

Export - Outbound data transfer in a format that can 
be used by other programs.

Focus – The point at which an image is properly de-
fined and details appear clearly.

Grain –Lightly speckled noise that is used to apply a 
more natural look to an image. 

Image - An array of pixels that make up a digital pic-
ture. 

Import - Inbound data transfer into a file or docu-
ment.

ISO - The amount of sensitivity of a digital camera sen- 
sor.  A higher ISO enables faster shutter speeds and/
or better performance in low light, but is more sus-
ceptible to experiencing increased noise.

Luma (Luminance) - The brightness in an image (the 
“black” and “white” or achromatic portion of the im-
age).  Luma represents the achromatic image without 
any color, while chroma components represent the 
color information.

Motion Blur - Caused by the camera moving during 
the exposure or by the subject moving during the 
exposure.

Noise - Visible effects of interference in an image from 
a digital camera.  Often appearing as random col-
ored dots sprinkled throughout the image or uneven 

Algorithm - Any bit of code or programming that de- 
fines a process.

Artifact- Any undesired alteration in data introduced 
during its digital processing.

Blur - Any area of a picture which is not sharply de-
fined. Lines and details which appear hard-edged in 
the scene have softer edges in the photograph.

Brightness - The degree to which a color sample ap-
pears to reflect light. 

CMYK - Cyan, magenta, yellow, and black. A color 
model commonly used for 4-color printing by printers 
to define and mix all of the colors they are capable of 
outputting.

Color - The human perceptual response to different 
wavelengths of light impinging on the photo recep-
tors in the retina.

Color Noise – A type of digital noise in which color 
edges are blurred or the image is unevenly colored 
and filled with spots.

Color Profile - defines the range of colors that can ap-
pear in a digital photo.

Contrast - Subjective differences in brightness be-
tween light and dark areas (highlight and shadow) in 
an image.

Download - The process of transmitting or transfer-
ring data from one device to another.
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Glossary
Preset - A pre-defined combination of parameters and 
settings that is saved into a folder within Topaz Detail 
2.  Topaz provides default presets.  A preview of each 
preset can be seen in the preset preview window lo-
cated at the top left hand side of the interface above 
the preset list. 

Preview- Shows the processed preview of the image.

RAW image - An image file format that contains un- 
touched, “raw” pixel information straight from the 
digital camera’s sensor.  It has yet to translate the in-
formation in each pixel into the full color information, 
so this format offers more control over how the final 
JPEG or TIFF image is generated. 

Reduce Blur - An de-blur function that uses decon-
volution technology rather than simple sharpening 
techniques.

Refine – Improve (something) by making small changes to 
make it more subtle and accurate. 

RGB - Red, Green, Blue.  The color model that is used 
in digital cameras and by computer monitors.

Sharpening - The process by which the apparent de-
tail and sharpness of an image is increased.

Sharpness - The clarity of detail in a photo.

Smoothing - To make a surface more regular or con- 
sistent; free from perceptible projections, lumps, or 
indentation

coloration in what should be smoothly-colored areas. 
It is most likely to show up in the darker or shadowed 
areas of an image.  Noise can be an undesirable effect 
that detracts from overall image quality or something 
you can choose to create artistically.

Out of Focus/Focus Blur – The point at which an im-
age is not properly defined and details do not appear 
clearly.

Pan and Zoom - A useful function that allows users to 
magnify the captured image in the preview and then, 
by using the cursor, to move or pan around the image. 
Typically Pan and Zoom allows users to magnify the 
image 2x or 4x time.  By magnifying the images and 
zeroing in on a specific section, you can see details 
not visible when the entire image is sized to fit the 
preview.

Parameter - A numerical or other measurable factor 
forming one of a set that defines a system or sets the 
conditions of its operation.

Photo-editing or Imaging software – Programs in 
which you can alter your photos and / or create digital 
images.  Depending on the software, you can improve 
exposure, color and other attributes of your picture, 
paint on it, add type, apply special effects, remove 
noise, resize it, combine it with other pictures, pre-
pare it for e-mail or posting on the web, output it to a 
printer, or do any number of other manipulations or 
edits.

Plug-in - A computing feature with the ability to be 
added to a system to give extra features or functions.
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empty spot and paste the Topaz_InFocus.plugin file 
into the Photoshop Plug-Ins folder. 
3. Quit and restart Photoshop and Topaz InFocus will 
appear in your Filters menu. 

“Do you have any other InFocus tutorials?”
Yes, please see pages 28, 33, 41 and 47 of this Topaz In-
Focus user guide, and also visit: http://www.topazlabs.
com/tutorials/InFocus

“I do not have Photoshop, will  InFocus work with my 
Elements, Aperture, Lightroom, iPhoto Paint Shop 
Pro, Photo Impact or Irfanview?”
Yes, you can use Topaz InFocus with any of the above 
host programs. However, to use InFocus in Aperture, 
Lightroom or iPhoto, you will need to download the 
free Topaz Fusion Express add-on. For more informa-
tion please visit: www.topazlabs.com/fusion

“What are the limitations of the trial version of your 
software?”
The only limit on the trial versions of the Topaz plug-ins 
is time. The free trial versions are designed to enable 
you to experience the full functionality of our plug-ins 
for a 30-day trial period. After the trial period is up, you 
will only be able to use the Topaz software by purchas-
ing it. You will then receive a license key to activate the 
plug-in, and the trial version will automatically become 
the full version with no time limitations.          

“I need a Topaz InFocus trial key.” 
Visit http://www.topazlabs.com/downloads for a trial 
key. Please check your Spam folder because your Spam 
filter sometimes filters out the automated email. 

If you need more time to evaluate, please e-mail us at 
www.topazlabs.com/support for an extended trial key. 
 

 “I can’t find Topaz InFocus in the Photoshop Filters 
menu.” 
If you’re using Windows: 
1. Go to C: \ Program Files \ Topaz Labs \ Topaz InFocus 
\ Plugins. Right click the file “tlInFocus.8bf” and click 
“Copy”. 
2. Go to your Photoshop Plug-Ins folder, usually located 
at C: \ Program Files \ Adobe \ Adobe Photoshop CSx \
Plug-Ins. First, delete anything that is currently there 
that has to do with Topaz InFocus This includes any 
folder that might be labeled “Topaz InFocus” or any 
tlInFocus.8bf file. After doing that, right-click on any 
empty space and click “Paste”. 
3. Quit and restart Photoshop and Topaz InFocus will 
appear in your Filters menu. 

If you’re using Mac: 
1. Go to Macintosh HD / Library / Application Support / 
Topaz Labs /InFocus4 / Plug-ins and right-click Topaz_In-
Focus.plugin. Click “Copy”. 
2. Go to Applications/Adobe Photoshop CSx / Plug-Ins 
(or wherever your Photoshop Plug-Ins folder is lo-
cated). Delete any current reference to Topaz InFocus. 
Afterwards, right-click any 

Frequently Asked Questions
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Frequently Asked Questions
“If I use the 30-day trial version will I need to uninstall 
the trial version before I upgrade to a full version?”
No, the Topaz trial software is designed to be unlocked 
to become the full version simply by entering a license 
key. The full license key will be e-mailed to you immedi-
ately after you purchase the software.

“Where do I enter my key?”
To enter your key please open an image in Photoshop 
and go to Filter -> Topaz Labs -> InFocus -> Menu -> 
Enter Key. You can then copy & paste or type in your 
license key and then select OK.

“I had Topaz InFocus as a trial, then I purchased. How 
do I enter my new license key?”
You can enter your new license key by opening up an 
image in Photoshop and go to Filter -> Topaz Labs -> In-
Focus -> Menu -> Enter Key. Please remove the trial key 
and enter your new purchased license key, then select 
OK and you are all set. 

“My Topaz InFocus key doesn’t work!”
There are a couple of reasons why Topaz InFocus might 
think your license key is invalid.

First, make sure that your key is in the proper format. 
It’ll be in the format “xxxxxx-xxxxxx-xxxxxx-xxxxxx-
xxxxxx” and will be all numbers in 30 digits in five 
groups of six (no letters). 

Second, make sure that as you’re entering the key 

there is nothing in the space beforehand. This means 
clicking, pressing Ctrl-A, and hitting delete to make sure 
that absolutely nothing is in that field before you paste 
in the key.

If it doesn’t work when you copy and paste, try typing 
it out, and vice versa.

My Topaz filters are grayed out in the filter menu. 
Please make sure that you are using a 8-bit or 16-bit 
image that is in RGB color mode.  Also, if your project 
includes adjustment layers please make sure that you 
are not on an adjustment layer.  You will need to select 
the image layer.  This will allow you to access your To-
paz programs. 

“I can’t access the Motion Angle slider!”
You must be in the Straight Motion blur type to access 
this slider.

“I can’t access the Estimate Blur button!”
You must be in the Unknown/Estimate blur type to ac-
cess this button and feature.

“My Estmate Blur feature doesn’t work!”
You must push the Estimate Blur button for the auto-
estimation to occur.  If you change the Blur Radius or 
Edge Softness parameter, you must push the Estimate 
Blur button after each change for the new estimation 
to occur.
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Frequently Asked Questions
“Where did the Edge Softness slider go?”
This slider will only be visible and accessible in the 
Uknown/Estimate blur type.

I have a question not listed here. 
Please visit our knowledge base online at: 
http://www.topazlabs.com/support/kb/

If you are not able to find the answer there then con-
tact our support specialists online at: www.topazlabs.
com/support or e-mail customer support at: help@
topazlabs.com
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Shortcut Keys
Topaz InFocus uses some shortcut keys to speed up your workflow.  Many of these 
keys are similar to those in Photoshop. The following keys work at all times.  

Mac  and PC Shortcuts are the same unless indicated otherwise. 

B           Expands / Collapses Deblur Tab
CMD - Shift - S   Ctrl - Shift - S     Expands / Collapses Sharpen Tab 
S           Takes a Snapshot
CMD-Shift-P   CTRL-Shift-P    Recalls previous Snapshot
CMD-Shift-N   CTRL-Shift-N  Recalls next Snapshot
CMD-1    CTRL-1  View Original Image
CMD-2    CTRL-2  View Adjusted Image
Left or Right Arrow Key       Scrolls through presets
Return (enter) key         Applies selected preset
[ key            Reduces selected slider value by 0.1
] key           Increases selected slider value by 0.1
Home Key           Set the slider value to minimum
End Key              Set the slider value to maximum
Double-click slider name        Resets the slider to it’s default value

Spacebar       Spacebar       View Original Image 
CMD-ALT-R    CTRL-ALT-R       Reset All 
CMD-ALT-0  CTRL-ALT-0  Zoom to 100%
+ or CMD - +    + or CTRL - +      Zoom In 
- or CMD - -   - or CTRL - -           Zoom Out              
CMD -Z     Ctrl - Z       Undo               
CMD - Shift - Z   Ctrl - Shift - Z     Redo              

MAC Shortcut       PC Shortcut       Action
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Connect with Topaz

Follow us on Twitter for notifications of 
recent news and easily get in touch with us 

whenever you feel like it!

Find us on our Facebook page and network 
with other Topaz users!

Participate in the entirely user-led Topaz 
Flickr group for a helpful and highly active 
community for Topaz Photoshop plug-ins!

Subscribe to our YouTube channel to keep 
up with any newly released product video 

tutorials!

Check out our new Forum and our blog for 
tutorials, tips and updates from Topaz Labs!
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Topaz Labs LLC, a privately owned company in Dallas, Texas, focuses on developing advanced video and image enhance-
ment technology. With today’s widespread use of digital still cameras, digital video cameras, and HDTV, the need for high-
quality digital images and videos has greatly increased. Topaz Labs’ mission is to bring practical state-of-the-art image and 
video enhancement technology to both professionals and consumers.

Contact Information
 

Topaz Labs LLC
5001 Spring Valley Road
Suite 400 East
Dallas, TX 75244

Technical Support
Visit: http://topazlabs.com/support/
Email: help@topazlabs.com

Copyright © 2009 Topaz Labs, LLC. All rights reserved. http://www.topazlabs.com
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Be sure to check out the complete line up of Topaz products. 

Go to http://www.topazlabs.com/downloads to get your 30-day free trial!

Ultimate control over 
image exposure, detail, 
and color gives you the 
power to make your 
photos pop.

Specializes in creat-
ing crisp and stylized 
images. Also features 
extensive smoothing 
capabilities. 

Advanced noise reduc-
tion filters noise while 
maximizing and retain-
ing image detail simply 
and effortlessly.

Takes any of your 
regular photos and ef-
fortlessly turn them into 
beautiful works of art.

The superior image-
sharpening solution 
that actually recovers 
lost detail, refines with 
micro-contrast detail 
enhancement and 
restores clarity to blurry 
images.

Advanced JPEG artifact 
reduction filters elimi-
nate JPEG compression 
artifacts while preserv-
ing image detail like 
never before. 

3 levels of intricate and 
specific detail enhance-
ment for naturally 
enhanced images with 
no halos. 

Bring the power of 
Topaz to your Aperture, 
iPhoto and Lightoom 
workflow with the new 
Fusion Express plug-in.

Remove unwanted 
backgrounds from your 
digital images quickly 
and easily with the new 
Topaz ReMask. 


